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BSD CostLink/AE
now includes RS
Means Commercial
Cost Models for 70
different building
types. These models
make possible the
generation of
detailed cost
estimates very early
in a project. Further-
more, the estimates
can be refined as the
project design
develops by adjust-
ing quantities and
substituting materials
and systems for those
used in the model. If
the cost estimate is
adjusted periodically to remain coordinated
with changes in the project design, the final
cost estimate should be a reliable predictor
of actual project cost.

The RS Means models included in
CostLink/AE are constructed of up to 75
separate assemblies, and each assembly
comprises 1 to 25 tasks and/or material
components. The models are powered by a
series of formulas that calculate the quantity
of each assembly and the quantity of the
member tasks in each assembly. The
formulas are based on a small number of
key parameters such as gross building area,
length of perimeter, and number of floors.
These parameters, which are adjustable by
the user, are used by the formulas to project
assembly quantities such as exterior closure
area, slab on grade area, roof area, etc.

Realistic, Updateable Cost
Estimates at the Schematic Design
Phase

Check Out Our New
Download Center!
We have introduced a new “Down-
load Center” on our website.
Current and prospective customers
can now download fully functional
copies of our products, demos/
tutorials, FAQs, samples, white
papers, user manuals, pricing, and
more.  Go to www.bsdsoftlink.com
and click on Download Center on
the left hand menu.
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Both SpecLink+ and PerSpective have new
printing enhancements this quarter. Users
who like to print or copy their specifications
double-sided will appreciate a new
checkbox on the Page Setup dialog box
called “Start document on odd page”
(Figure C). If this option is selected (the
default is Off), a blank page will be added at
the end of each section or chapter with an
odd number of pages. This means that when
you are printing or copying multiple double-
sided documents, every section or chapter
will begin on the right.

You can also now control your printer
properties from within SpecLink+ and
PerSpective, allowing you to set up for
double-sided printing and for other printing
variations without leaving the program and
without affecting documents printed from

Printing
Enhancements in

BSD SpecLink®+ &
PerSpective®

What Does CostLink/AE Do?
First and foremost, CostLink/AE manages
the models. AE offers an intuitive, easy-to-
use interface to help choose a model type,

See “Printing Enhancements” on Page 5

See “Realistic Cost Estimates” on Page 2

Figure A - Commercial Cost Model in CostLink/AE



2 BSD LinkLine Fall 2003

“Realistic Cost Estimates” from Page 1

See “Realistic Cost Estimates” on Page 5

Advantages of SpecLink
Albert Kahn Associates, Inc. Switches to BSD SpecLink®

SpecEdit is a proprietary software developed by AKA. For over 40
years, it has been efficient, with excellent results.  Then why change
to different software? First, the word processing program previously
used to create specifications documents is outdated and no longer
has technical support.  Further, it has become increasingly common
for project specifications to be distributed electronically via email
or job-specific websites. While this change in production saves
costs, prior to emailing or posting a document, each section must be
converted to RTF or PDF file. On a project specification with 80
sections, this takes over 3,000 steps!

The new SpecLink+ database eliminates many of the old system’s
inefficiencies, allowing editors to “click-in” text at any time during
the specifications development process.  Utilizing editor options,
drop-down choice lists, or paragraph selections, users are able to

quickly and efficiently customize sections electronically. For greater
coordination, text can also be linked within or between sections of a
specifications document, and is only a step away from being linked
to notes on drawings. SpecLink+ also has the ability to output
specifications in hard copy, RTF and PDF format for electronic
distribution. On that same specification with 80 sections, this takes
only 16 steps!

The conversion of AKA’s master specification system to SpecLink
offers clients and AKA employees greater efficiency in document
production and improved document quality.

This article first appeared in the Industry Trends column in Issue 2,
2003 of the Kahn Update, and has been reprinted with the kind
permission of Albert Kahn Associates, Inc.

select a structural frame and exterior
closure alternative, input the gross
building size, review or adjust the
critical parameters used to generate
construction assembly quantities, and
adjust project location and markups.

On the Cost Models tab of the
Summary Info dialog box, the user
chooses a model category, shown in
Figure A, (Commercial, Industrial or
Institutional) and then uses the pull-
down to select a model type from
that category. After choosing the
model, the next step is to choose one
of the exterior closure and framing
alternatives. Then the estimated
building size and length of perimeter
must be entered. The major building
parameters can then be reviewed and
adjusted, if desired.

Each model has an associated set of
possible “Additive” items. An
accompanying tab on the Summary
Info dialog displays these additives
for the currently selected building
model. Additives are individual items that may or may not be
appropriate for your particular building. The user can scroll through
the list and enter the quantity of each item to be included in the
project. There is also a Cost Summary tab on the Summary Info
dialog box that allows the user to select any of 700 different U.S.
and Canadian locations, enter an appropriate sales tax, and adjust
contractor markups and other cost assumptions, such as the

architect’s fees. When this data has been appropriately adjusted, the
preliminary cost information for the project is complete, and the
user can print or preview a summary or a detailed cost estimate.

The user can navigate the standard tree structure of the project
hierarchy (Figure B) to view the individual assemblies and cost

Figure B - Individual Assemblies and Cost Items in CostLink/AE
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SpecLink+ Statistics:

• 782 sections total, 339 updated or new
(43%)

• 1 new generic section
• 446 generic sections, 189 updated or

new (42%)
• 13 new proprietary sections
• 336 proprietary sections, 150 updated

or new (44%)
• 122,686 paragraphs
• 133,078 internal links (targets and

consequences)
• 20,142 notes to specifier
• 2,797 notes with live hyperlinks to

Internet web pages

• 2,051 external documents referenced,
51% verified as unchanged or updated

• 8 documents obsolete, replaced or
removed

• 179 standards organizations referenced
• 1 new standards organization
• 64 new documents (never before

referenced)
• 1,998 manufacturer listings in generic

sections, 1,941 with live hyperlinks
• 846 unique manufacturers listed in

2,354 instances
• 857 unique manufacturers listed in 331

generic sections, 813 with live
hyperlinks

About Your SpecLink & PerSpective Updates

PerSpective Statistics:
• 179 chapters, 38 updated (21%)
• 25,972 paragraphs
• 30,384 links
• 4,101 notes to specifier
• 608 external documents referenced,

51% verified as unchanged or updated
• 76 standards organizations referenced

• 247 unique manufacturers listed in 335
proprietary sections

• 803 manufacturers listed in generic
sections but not in proprietary

• 204 manufacturers listed in proprietary
sections but not in generic

Standards published by the American Society for Testing and
Materials (ASTM) make up 43% of the 2,158 documents referenced
in SpecLink and PerSpective — the largest number published by a
single organization. All of the ASTMs referenced in SpecLink and
PerSpective were verified in the last quarter - 26% had been
revised, 3% reapproved, and 10 standards withdrawn. Each revised
standard was compared to the previous edition and evaluated for its
potential effect on the specifications, before updating the sections.
The ASTM updates affected 42% of SpecLink sections and 17% of
PerSpective chapters.

Monitoring the continual, irregularly timed changes to ASTMs
might be an almost impossible project, except that ASTM publishes
an annual 4-volume compendium of the standards referenced in the
model building codes, SpecLink and PerSpective, and other guide
specifications — ASTM Standards in Building Codes. BSD pro-
vides ASTM with a list of standards biannually. None of the
standards referenced in PerSpective or non-proprietary SpecLink
sections is missing from this set.

We use ASTMs in Building Codes as the “current” edition for
purposes of referencing edition dates for one reason:  It’s simple.
We know that most design professionals don’t have copies of many,
if not most, of the ASTMs referenced, so we’ve chosen as our
definitive edition the simplest (as well as the most economical) way
to purchase them. For $795, you get over 1,500 ASTM’s related to
construction, in print and with a CD-ROM. There are three other
ways to get ASTMs:  Individually at an average of $30 per standard;
individual volumes of the complete 78-volume set of all ASTMs at
an average of $150 each; or the entire collection for over $7,000 in
either print or CD-ROM. If you need only a single standard,
ASTM’s web store makes it easy and quick to get the very latest
edition.

So, if you decide to add ASTMs to your reference library, we
recommend ASTM Standards in Building Codes, published annually
in early July, for $795. If you are not an ASTM member, you can
get the 10 percent member discount if you place your order with
Margie Lawlor at (610) 832-9616; tell her you are a BSD SpecLink/
PerSpective subscriber. For more information, go to www.astm.org.

Notable Updated ASTMs

About the ASTM Updates

Asphalt Felts for Roofing:  Asphalt-saturated felt has
traditionally been designated by rather loose pound-weight num-
bers, such as “30 lb felt,” “43 lb felt,” etc.  These numbers refer to
the total mass of felt and asphalt in pounds per 100 square feet (a
traditional “roofing square”).  These designations are also some-
times shown as #30, etc. (pronounced “number 30”), or 30#, etc.
(pronounced “30 pound”).  In addition, asphalt felts have long been
manufactured in weights considerably higher than the minimums
specified in relevant ASTM standards, leading manufacturers to

describe them as “ASTM D 4869 30 pound felt,” or “#43,” for
example.  In addition to the weight, ASTM standards define the type
of felt (organic or glass fiber), minimum amount of asphalt, the tear
strength, and characteristics that relate to the use it is to be put to.
Felt for underlayment is not meant to be permanently exposed to the
weather, whereas  roll roofing is intended for weather resistance.

ASTM D 4869 — Standard Specification for Asphalt-
Saturated Organic Felt Underlayment Used in Steep
Slope Roofing — was significantly revised in 2002.  Where there
were formerly two Types, Type I and Type II, there are now four

See “Notable Updated ASTMs” on Page 4
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corresponding to the original three standards:  Class S (smooth
surfaced), Class M (mineral surfaced), and Class WS (mineral
surfaced with a “wide selvage”).  Selvage is a smooth edge not
coated with mineral granules, intended to improve adhesion in
lapped edges.  Class M is available with 2 inch or 4 inch wide
selvages or with no selvage.  Class WS has a “selvage” of approxi-
mately one-half the width, intended for a very wide lap joint
accomplishing a 2-ply roof.  Class S is available in two Types which
correspond to the minimum mass per unit area:  Type III, which is
51.1 lb/100 sq ft (2495 g/sq m), and Type IV, which is 39.8 lb/100
sq ft (1943 g/sq m).  These Type designations are the same as they
were in ASTM D 224 — the former Type I was very similar to Type
IV, and the former Type II was a little heavier in weight than Type
III. Class M is available only in Type II, which is the same as in
ASTM D 249 — Type I was slightly higher in weight.  Class WS is
available in two Types, Type III, which is 35.5 lb/100 sq ft (1733 g/
sq m), and Type IV, which is 42.8 lb/100 sq ft (2090 g/sq m).  Both
Type III and Type IV are the same as in ASTM D 371 — the former
Type I was similar to Type III and the former Type II was slightly
heavier than Type IV.  Remember that all these weights are mini-
mums and the standard covers other properties as well.

07825 _3M - GREASE DUCT FIREPROOFING:
3M; fire resistive duct wrap, a patented, non-asbestos, inorganic
blanket encapsulated by scrim-reinforced foil; and firestopping
sealants for use at duct penetrations; to fire rate commercial kitchen
grease ducts; 1 and 2 hour rated alternative to shaft enclosure.
www.3m.com

08380 ELI - TRAFFIC DOORS:
Eliason Corporation; minimal
maintenance swinging traffic
doors have gravity and offset
pivots for gentle swinging
action, and automatic, time
delayed closing without
springs, heavy cam castings, or
other mechanical closing
devices.
www.eliasoncorp.com

08840 POL - PLASTIC
GLAZING:
Polygal, Inc.; polycarbonate
structured sheets and glazing
systems for outdoor and
indoor applications requiring
light weight, exceptional
strength, maximum light
transmission, outstanding
insulation characteristics and
fire safety.
www.polygalusa.com

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Types (I, II, III, and IV).  Furthermore, the former Type II is now
Type III, which is bound to cause considerable confusion in the
industry.  The revised standard is apparently intended to cover other
products actually available, with four Types of different minimum
weights.  ASTM D 4869 formerly covered Type I, which was and
still is 8 lb/100 sq ft (390 g/sq m), and Type II, which was 20 lb/100
sq ft (976 g/sq m).  In the 2002 edition, the 20 pound type is now
Type III, while the new Type II is 13 lb/100 sq ft (635 g/sq m).  The
four Types are also designated as:  Type I—#8, Type II—#13, Type
III—#20, and Type IV—#26, with the # indications representing the
mass.  Because of the possible misunderstanding between the
former Type II and the new Type II, it is recommended that both the
Type and weight be specified, in the manner shown in the ASTM
(i.e. Type I—#8).  “30 pound” felt would be Type IV—#26 (mini-
mum 26 lb/100 sq ft).

ASTM D 6380 — Standard Specification for Asphalt
Roll Roofing (Organic Felt) — is a standard first published
in 1999 combining three existing standards:  ASTM D 224, D 249,
and D 371.  The latter have now been withdrawn in favor of the
consolidated standard.  There are three Classes of roofing felt,

03540 DCC - CEMENTITIOUS UNDERLAYMENT:
Dependable Chemical Company; Skimflow ES is a latex modified,
cement-based, self-leveling underlayment; extended set material
provides the working time needed for interior floor leveling and
repair applications over existing substrates.  www.floorprep.com

05511 ALC - METAL LADDERS:
Alaco Ladder Company; fixed and folding aluminum wall ladders
and ship’s ladders. www.alacoladder.com

05720 CSJ - ORNAMENTAL HANDRAILS AND
RAILINGS:
C. Sherman Johnson Co., Inc.; guardrails made with stainless steel
cable fittings or rod infill made by Johnson.  Johnson does not make
railing framework, so this specification is addressed to the railing
fabricator rather than to the cable and fittings supplier.
www.csjohnson.com

07213 JMI - GLASS FIBER BUILDING INSULATION:
Johns-Manville; this section covers only a portion of Johns-
Manville’s insulation product line:  formaldehyde-free batt insula-
tion.  Includes polyethylene encapsulated batt for use above lay-in
ceilings, unfaced sound control batt, and unfaced thermal batt.
www.jm.com

07213 KFG - GLASS FIBER BUILDING
INSULATION:
Knauf;  renamed from 07210 - BUILDING INSULATION because
it covers only glass fiber insulation.

New Proprietary Sections

“Notable Updated ASTMs” from Page 3

See “New” on Page 5
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This will be the last quarter that we update
the 16-bit SpecLink product, so we strongly
recommend that our few remaining
SpecLink users make the switch to
SpecLink+ during this quarter. The Release
Notes this quarter include a number of
pointers for easing the transition, and we’re
certain you will quickly come to appreciate
the many new features available to you in
the 32-bit product.

Update Ending for
16-bit SpecLink

other programs. To change your
printer settings for SpecLink+ or
PerSpective, click on the File menu,
then click on Print, thereby opening
the Reports dialog box. From there,
you can make changes to the follow-
ing settings that apply to all projects
and printers without affecting the
printing for other applications:

• Paper size
• Number of copies
• Paper source (tray)
• Print duplex mode
• Print in color.
These settings remain fixed for all
projects printed from SpecLink+ and
PerSpective until they are reset from
within the program. In addition, you
can click on Printer Setup from the
Reports dialog box, where you can
select your printer and change the
page orientation for the specific
project without affecting other
projects or applications.

We’ve made a number of other
changes that are discussed more fully
in the Release Notes, which we
recommend that you review.

“Printing Enhancements” from Page 1“Realistic Cost Estimates” from Page 2

items in the project. It is possible to replace
the formula-calculated quantity on any item
with a quantity estimated or calculated by
the user. The user can also add (and delete)
assemblies and cost items using any of the
RS Means Assemblies and Cost Items
provided with the software. Such adjust-
ments and substitutions should be made
periodically, to keep the estimate coordi-
nated with the project design development.
The user can also experiment with alterna-
tive assemblies and building elements to
investigate the effects on project cost.

Conclusion
BSD is the only company that provides the
RS Means modeling capability integrated
with a full-featured estimating system.
CostLink/AE combines the extensive
models database with the estimating power
of nearly 11,000 assemblies and 20,000 cost
items in an easy-to-use, drag and drop
interface. Several levels of presentation
quality reports add the finishing touch to a
very clean and professional cost estimating
system that will be useful to any design
professional interested in controlling
building costs.

For a full list of Building Type Models, see
our Download Center at
www.bsdsoftlink.com.

09673 TNE - CONCRETE FLOOR COATINGS
TNEMEC Company, Inc.; coating systems for concrete floors.
Includes silicate blend sealer/dustproofer; epoxy and epoxy/
urethane coating and laminate for mild to moderate abuse, and
epoxy mortar for moderate to heavy abuse.  www.tnemec.com

09960 TNE - HIGH-PERFORMANCE COATINGS
TNEMEC Company, Inc.; coating systems for commercial and
educational facilites; systems for interior and exterior surfaces,
including metal, masonry, gypsum, and other substrates, enduring
mild to heavy abuse, including weather, UV, chemical, and water
exposure.  www.tnemec.com

10650 MOD - OPERABLE PARTITIONS:
Modernfold, Inc.; electric and manual operable partitions. Acousti-
Seal partitions are movable flat wall products used for excellent
sound performance and attractive appearance.
www.modernfold.com

10730 SCA - COILING INSECT SCREENS:
Screen America Corporation; vinyl coated woven fiberglass mesh
insect screens; motorized or manual operation.  For screens exposed
to weather, and not built into the header or soffit, color coordinated
aluminum housings are available.  www.screenamerica.com

11131 DRA - PROJECTION SCREENS:
Draper, Inc.; wall and ceiling mounted front projection screens.
www.draperinc.com

11151 DKI - PARKING GATES AND OPERATORS
DoorKing, Inc.; swing-up arm gates; operators for overhead,
swinging, and sliding gates provided by others.  www.doorking.com

02457 BSD - STEEL SHEET PILES
Permanent earth retaining structures made with steel sheet piling
such as caissons, quay walls, and retaining walls.

New Generic Section

“New” from Page 4

Figure C - Page Setup in SpecLink and PerSpective
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All Products

I want to move the software from
one computer to another, but the

access key won’t work.  Why is that?

The access key you received when
you installed the software is specific

to the computer on which it was installed.
To move the software to another computer,
call Tech Support at 800-266-07732 for an
Un-permit code before you remove the
software from the first computer.  Before
you call, you can have the software already
installed on the new computer, and then
after getting the Un-permit code, Tech
Support can generate a new key for the new
computer.

How can I tell the file name and
location of the project I have open?

From the File menu, choose Sum-
mary Info. The file name and

location are listed at the top of the Summary
Info dialog box.

I want to start BSD software from an
icon on my desktop. How do I do

that?

To start any program from your
desktop, you create a shortcut. To

create a shortcut, open Windows Explorer
(either by right-clicking on the Start menu or
by holding down the Windows key on your
keyboard while typing the letter ‘E’) and
size it so that you can see your desktop in
the background. Navigate to where the
software is installed (the default location for
PerSpective is C:\Program
Files\PerSpective, the default location for
SpecLink is C:\SpecLink+, the default
location for CostLink/CM is C:\CostLink
CM, and the default location for CostLink/
AE is C:\CostLink AE). Locate the execut-
able file (Persp32.exe for PerSpective,

SpecLnk+.exe for SpecLink, CstLnkCM.exe
for CostLink/CM, and CstLnkAE.exe for
CostLink/AE). With your right mouse
button, drag the executable file to your
desktop. Release the right mouse button
when it is over the desktop and a menu will
open. From the menu, choose Create
Shortcut Here. If you created the shortcut
properly, it will have a little arrow on the
bottom left corner. If it does not have a little
arrow, then you moved the exe instead of
creating a shortcut. Move it back and try
again using the right mouse button only.

When I create new projects, I always
want to save them in a certain folder

on my server. Is there a way to make the
software save to that folder automatically?

Yes, you can specify a default
directory where projects should be

saved. To specify a default directory, open
the software and close any open projects.
From the File menu, choose Permissions. In
the Permissions box, click the System
Settings tab. The fourth field down is called
Project Location. Click the yellow folder
icon to the right of that field and navigate to
the folder where you want your new projects
to be saved by default. Then Click OK. The
next time you create a new project, if you
type the name in the New Project line, the
project will save to the specified folder. If
you want to save the new project to a
different location, click the yellow folder
icon to the right of the New Project line and
navigate to the correct location.

I’m trying to open a file that is on my
server and I keep getting error 3051

cannot open file. What does that mean?

You need to have full access to
where the project file is located -

read, write, edit, delete. If you do not know
how to change this, ask your system
administrator.

BSD CostLink/AE &
CostLink/CM

I want my tasks in CostLink/CM to
print in a specific order on my detail

report.  Can I do that?

By default, line items are sorted by
the source tag.  If you would like

your line items in a different order both on-
screen and in your detail reports, turn on the
sequence column.  From the Tools menu,
choose User Options.  In the User Options
dialog box under Select Project Panel,
choose Project Sheet. The right side of the
dialog box will update to show a list of
available column types.  In the Include
column, click to place a checkmark in the
checkbox for Seq (Numeric user-defined
sort order).  Click the Close button.  The
Seq column is now displayed in the Sheet
Panel.  Type numbers in the Seq column.
Click on a different title and back on this
one - the tasks are sorted by the sequence
column.  When the sequence column is on,
the tasks are first sorted by the Seq column
and then by the Source Tag column.

Do the costs in the R.S. Means
database include the installing

contractor’s overhead and profit?

In CostLink/AE, they do.  In
CostLink/CM, they don’t.  In

CostLink/AE the bare costs equal the
arithmetic sum of Material (which is the
bare material cost plus 10% for profit),
Labor (the base labor cost plus total
overhead and profit), and Equipment (the
bare equipment cost plus 10% for profit).
In CostLink/CM, you have the flexibility to
define the subcontractor markups for each
contractor individually.  Details for the
calculation of Overhead and Profit on labor
are shown on the back cover of the appro-
priate R.S. Means cost book.

I printed my cost summary and the
number on the report does not

correspond to what is on screen.  What
would cause that?

The first thing to check is the
unassigned folder.  Task items in this

folder do not roll up into the costs on the
reports.  You need to assign them to the
appropriate folder in your project.

I need to email my reports to
someone who does not have the

CostLink software.  How can I do that?
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More questions?
Contact BSD Technical Support:

Toll Free: 800-266-7732
In Atlanta: 404-365-9226

Email: support@bsdsoftlink.com

Reports can be exported to a number
of file formats using the Export

button in the Print Preview window.
Exported files can be emailed to individuals
who do not have CostLink, saved as archive
copies of estimates, published on websites,
or edited.  Some of the more popular export
options include: Acrobat Format (PDF),
Excel (XLS),and Rich Text (Exact) Format
which can be opened and edited in any word
processor except WordPerfect 5.1.  Note
that if someone wants you to email an
electronic copy of the estimate and they
have CostLink, you can use the File > Save
to Compressed feature to create a zipped
file that you can attach to an email. They
can then open the estimate in CostLink,
make edits, and send it back.

I want to copy just folders from the
assemblies database into my project.

How do I do that?

You can do that by dragging and
dropping using your right mouse

button.  It is easier if you have both data-
bases open and tiled vertically.  When you
drop the folder into the project database,
choose the option Copy Folders Here. If you
do not need all the folders you copied in,
you can use the Delete Empty Folders
option under the Tools menu to remove the
empty folders.

BSD SpecLink+ &
PerSpective

I am getting a message that it is time
to install my update and that I must

install it to gain access to the software.  I
just renewed my subscription, so why am I
getting this message?

There are two different effective
dates for the software.  One is your

subscription effective date and the other is
the master database effective date.  Your
subscription expires once a year, and the
software master expires each quarter.  The
two dates are not related.  To see both dates,
close any open projects and click on File
and then Permissions.  If you have not
installed your update by the time the master
expires, you will no longer have access to
the software. (There is a 4-week grace

period from the end date of the master
database effective dates you see in the
Permissions box).  Installing the update will
allow you to use the software.  If your
subscription has expired and you have
already renewed it, you need to enter the
access key that you were emailed when you
renewed your subscription.

I am getting an error 3343 when I
open my project, or when I start the

software.  How can I resolve this error?

Sometimes a Microsoft Access
database becomes corrupt or

unstable, and needs to be repaired. If the file
that is generating this error is the project
you are trying to open, then go to the File
menu and choose Repair/Compact Project,
and then navigate to the project you are
trying to open.  That should resolve the
error.  If the file that is generating the error
is the master.spm file, then you will need to
reinstall the software.  If the file referenced
in the error is your aecLMDat.MDB, then
you can resolve it by choosing Repair/
Compact aecLinkMan from the File menu.

How do I rename a section or
chapter?

To change the name of a section or
chapter, click on the name of the

section or chapter in the Tree panel so that it
displays in the Document panel. The current
name of the section or chapter displays in
the Sequence 0000 paragraph in the
Document Panel. Drag across the entire
name in the Document Panel so that it is
highlighted, then type the new name over
the old name. Click on another paragraph so
that your edit will be saved. The Tree Panel
will update to the new name and the new
name will print in the header or footer when
the Section Name or Chapter Name key-
word is used.  It will also update the
automatic Table of Contents report in
SpecLink.

How can I find a section in SpecLink
or a chapter in PerSpective if I don’t

know the ID number?

Included with each quarterly update
is a listing of all the documents,

numbers, and descriptions. This electronic
listing can be found on the CD under the
Info folder inside the SpecPlus or PerSpec
folder named after that quarter (for example
2003Fall.doc or PSPcatalog_fall2003.doc).
Open this document in a word processor to
search it using the Find command.

How can I make a proprietary spec
into a generic (non-proprietary)

spec?

In cases where a non-proprietary
spec is desired but only a proprietary

spec is available, it must first be determined
if the product listed is in fact unique. If it is
not unique, and there are other known
manufacturers, then these should be listed
under the Manufacturers section of Part 2.
In the absence of listed manufacturers, the
language “or equal” could be added. The
section should also be searched for refer-
ences to specific product names or ID
numbers and these should be removed or
made more general.

I want to email my project to
someone who does not have the

software.  How can I do that?

You can email an individual section
or chapter, a branch, or the entire

project.  To do that, click on the File menu
and then select Print.  From the Report
Setup dialog box, select Document as your
Report to Print, and select Section/Chapter,
Branch or Project as the Scope of Report.
Then click on the Export button on the right
side of the dialog box.  Select the folder
where the files should be created.  You will
have an RTF (rich text format) file for each
section or chapter.  These can be emailed
and/or opened in most word processors.



Training Schedule

LinkLine

PRESORTED
STANDARD

U.S. POSTAGE
PAID

ATLANTA, GA
PERMIT NO. 6613

3520 Piedmont Road, NE
Suite 415
Atlanta, GA  30305

BSD SpecLink+
Workshop Changes

The BSD SpecLink+ Workshop has been
changed to two one-day workshops.  The
first day is devoted to learning the basics
of SpecLink+, including how to navigate
within the software, start a new project, edit
sections, understand how the links and
choices work, and how to format, print and
export the final document.  It is designed
for new users.  The second day is designed
for those who want to learn how to create
and maintain their own office master.  This
day covers the concepts of an office mas-
ter, how to customize your master by add-
ing choices, links, and tags, as well as cre-
ating your own Wizards.  Users must al-
ready be familiar with the basics of
SpecLink+ to attend the second day.

BSD SpecLink+
Either Day*  $495
Both Days*  $895

September 8-9
October 20-21
December 8-9

2004 Dates
January 20-21
March 16-17

April 6-7

AIA Members: Submit Course Completion
Certificate for 7 or 14 Continuing Education

Units
CSI Members: Submit Course Completion
Certificate for 7 or 14 Education Contact

Hours (ECHs) toward your CCS, CCCA, or
CCPR Certification renewal

* Class starts at 9:00 AM and ends at 5 PM.

BSD CostLink/CM
3-1/2 days*  $1295

October 14-17
December 2-5

2004 Dates
March 2-5

June 29-July 2
September 21-24
December 14-17

AIA Members: Submit Course Completion
Certificate for 24 Continuing Education Units

CSI Members: Submit Course Completion
Certificate for 24 Education Contact Hours
(ECHs) toward your CCS, CCCA, or CCPR

Certification renewal

* Class starts at -8:30 AM on Tuesday
morning and ends at 11:30 AM on Friday.

View BSD class schedules on our website! Go to www.bsdsoftlink.com and click the Training link. Get directions and information on travel, hotels, and Atlanta!


